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documentation.  
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1.01 Introducing QDMS 
 
In any Drawing Office, on any Construction Site, or in fact anywhere else where there are 
large quantities of  documents, there will be a Register of Documents . With time, documents 
are revised, new documents are created, and documents become superseded. The document 
register is continually updated to reflect these changes.  
  
When documents are issued from one par ty to another, they are generally issued under a 
transmittal. This is a cover sheet that lists the issued documents, their status, the reason for 
issue etc. A transmittal is the means by which document issues are controlled.  
 
QDMS is a Document Management  and Transmittal System  developed by QA Software to 
electronically maintain a document register, to generate transmittals for the issue of new 
documents, and to manage the distribution of revised documents.  
 
Though this may sound simple, in today’s fast tra ck environment, control of documents is 
fundamental to the smooth operation of any Project and is often managed badly. Handwriting 
of transmittals is time consuming and a manually maintained distribution matrix, (or more 
common still, a distribution matrix  held only in someone’s memory) is prone to error and 
potential disaster.  
 
QDMS is a powerful and flexible PC based system. It has been designed to be as simple to 
use as possible while offering the maximum power for the advanced user.  
 
QDMS has been devel oped to assist companies in meeting the requirements of ISO 9000 
standards for document control, but offers far more than the means of simply meeting this 
standard.  
 
 
1.02 Highlights 
 
QDMS is special because it has been developed on the job. People actual ly doing document 
control have written it.   
 
QDMS displays information in a spreadsheet format that enables the user to see multiple 
records at a glance.  Flexibility has been considered of primary importance. Data can be 
browsed, or reports generated in a wide variety of ways. A powerful filter generation facility is 
incorporated for editing or reporting on selected information only.  
 
QDMS generates an audit trail for all revisions to documents and document Issues.  
 
Data entry with QDMS is rapid with sin gle line or batch entry for new documents. Documents 
are selected for generating transmittals by simply tagging the documents in the Document 
Register. The distribution of revised documents is almost completely automated. Full 
automation has not been imple mented in order to provide the user with the final control 
button. 
 
Importing and Exporting from and to other systems is a built -in feature of QDMS. The system 
can generate electronic transmittals that can be imported by other users. All, or only selected 
records within any QDMS data file can be exported from within the system to most popular 
software packages such as Excel, Lotus, etc.  
 
QDMS is designed so that you can access the information you want quickly and the system 
operates with standardized Tool b uttons for maximum user -friendly operation. 
In an environment with electronic versions of drawing files, QDMS has an optional viewer 
which can read most of the common CAD file formats. The viewer also has red lining facilities 
which can be controlled per u ser. 



Chapter 1 – Introduction 

QDMS Version 5 Guided Tour    Page 7 

1.03 How to get started with QDMS  
 
QDMS requires installation of some software. This can be obtained from  
www.qa-software.com or by contacting QA Software on:  
 
Phone:  +61 (3) 9326 8455 
Fax: +61 (3) 9326 6544 
Email:  sales@qa-software.com  
 
Use the Quick Start Instructions contained in Appendix A at the end of this document to 
Install the Software.  
 
 
 
 





 

QDMS Version 5 Guided Tour    Page 9 

Chapter 2 – QDMS Simple Guided Tour 
 

2.01  About the QDMS Guided Tours 
 

2.02  Login 
 

2.03  The Master Document Register 
 

2.04  Adding a New Document  
 

2.05  Creating a Recipient 
 

2.06  Generating a Transmittal 
 

2.07  View the Transmittal History 
 

2.08  Receiving Revised Documents 
 

2.09  The Document History File 
 

2.10  Transmittals Pending 
 

2.11  Transmitting Revised Documents 
 

2.12  View Transmittals Detailed again 
 

2.13  Exiting QDMS 
 
 



Chapter 2 – QDMS Simple Guided Tour  

QDMS Version 5 Guided Tour    Page 10 

2.01 About the QDMS Guided Tours  
 
What follows is a simple guided tour, which takes you through the most basic features of 
QDMS.  
 
Please follow the steps below sequentially if using the program for the first time. Type data 
exactly as indicated in these instructions as it may be referenced later in the Chapter.  
 
For maximum benefit from this exercise, note changes that take place o n the screen with 
each step. 
 
 
2.02 Login 
 
If QDMS has already been installed on your computer but you are not at the Login screen, 
you need to start the program by clicking on the Start button, selecting Programs, locating 
the work group QA Software, and selecting QDMS Drawing Management . You will then be 
presented with the Login Screen. Alternatively, if you have a short cut icon on your desktop 
for QDMS, double click on this to start the program.  
 
1. Select the User ID as QA and press Tab (your login detail s appear on the right)  
 
2. Enter the Password  as QA and press Tab (a list of projects you have access to appear)  
 
3. Select the Demonstration  Project by double clicking on it, or select it and click on the 

OK button. 
 

 
 

Note that the log in screen is normall y populated automatically until QDMS is registered 
with both the User ID and Password as QA.  

 
 

 
 
 
 
 
The program main menu will then be displayed.  

1 

2 

3 
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The above screen is called the QDMS Dashboard . At the top of the screen is the Main 
Menu.  
 
Displayed as a list under Favorites are some commonly used QDMS menu items. These 
menu items are fully customisable for each user. During the guided tour you should use the 
main menu options rather than the short cuts on the Favorites list to gain familiarisation wi th 
the menu system.  
 
 
2.03 The Master Document Register  
 
The Master Document Register  (MDR) is a key file in QDMS. This is where the system 
stores the latest revisions of all documents. All documents in QDMS (both new and revised) 
are processed into QDMS t hrough the Master Document Register. Note that the MDR only 
stores information regarding the latest revision of each document. When Documents are 
revised, superseded documents are automatically moved to a separate file called the 
Document History file . 
 
4. Select View from the main menu and then select Master Document Register from the 

sub menu as follows:  
 

Main Menu 

Favorites 
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The Master Document Register  will open in the format of a spreadsheet as shown below:  
 
 

 
 
At the top of the screen is a Toolbar. The buttons on this toolbar and meanings of common 
Function keys are explained below. Most buttons also have associated tool tips when you 
position your mouse over them.  

 
Button/ Function 
Key 

Purpose 

 
 

Close 
This button is used to close the MDR.  

 or F4 
 

New Document 
Used to add a new document to the MDR.  

Toolbar 

5 

4 
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 or F5 
 

New Duplicate 
Used to add a new document to the MDR, duplicating the 
information from the current document.  
 

 or Ctrl+End 
Move to the bottom of the register.  

 or Ctrl+Home 
Move to the top of the register.  

 or Ctrl+L 
Look for 
Used to locate a specific document containing specific text in any 
column. 

 or F7 
 

Find 
Find a Document via it’s number.  

  
 

Filter 
Used to locate documents that match specified criteria.  

 
Preview 
Preview a report.  

 
 

Print 
Print a report.  

 
Renumber 
Renumber a document.  

 
 

Undo 
Used to undo the last edit. This option is not available if a user 
movers to another document first.  

 
 

Delete  
Used to delete the current row.  

F8 Enters current date in a Date field. 

End Move to End of Text.  

Home Move to Beginning of Tex t. 

 
 
2.04 Adding a New Document   
 
The are a number of ways of registering new documents into QDMS. One of the simplest is to 
add documents directly in to the Master Document Register. Note that QDMS stores both 
incoming and outgoing documents in the Maste r Document Register. The FromCompId 
(From Company ID) field indicates whether a document is internal or from an external party.  
 
To add a new document:  
 
5. Press F4 or click the New Document  button to open the Document key information 

window. 
 
6. In the field Document No  type DUMMY-A and press Tab. 
 
7. Click the down arrow next to the Rev field and select 1 from the drop-down list. 
 
8. Click the down arrow next to the Sts field and select 3 from the drop-down list. The fields 

in the key information window should now be as shown below: 
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9. Click OK to add this document and return to the Master Document Register.  
 
10. Enter the Title for the document as Dummy Document A  and press Tab. 
 
11. Type the FromCompId value as JKN or select this from the drop down list in the 

Company field. Press Tab. 
 
12. Enter the Transmittal Received number as TR005 and press Tab. 
 
13. Enter the Received date by pressing F8 when in the Received  field and press Tab. Note 

you could also right click on the Received field and select Today to enter this date. 
 
To add another document:  
 
14. With your mouse still on the row for document DUMMY -A, press the F5 key or click the 

New Duplicate button. This is used to create a document with similar attributes to the 
document just entered. The Document key information bo x will open again. This time 
change the A to a B in the Document Number field to create a document DUMMY –B and 
then click OK.  

 
15. Back at the Master Document Register, change the title of Document DUMMY -B by 

changing the A to a B. (Tip: Press the End key to go direct to the end of the Title and then 
Backspace.) 

 
Notice that the other fields such as FromCompId and Transmittal  Received  have been 
“duplicated” from Document DUMMY -A. 

 
16. Add a third document DUMMY-C as per steps 14 and 15 above.  
 

Note that there are numerous additional attributes that can be captured about documents 
in QDMS. These include Disciplines, Types, Zones and the like. You will see some of 
these additional attributes later in the Guided Tour. You can even add your own fields to 
the Master Document Register if required.  

 
17. Click on the Close button on the far right of the Toolbar to return to the Dashboard. 
 

6 

7 

8 

9 
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2.05 Creating a Recipient  
 
Recipients in QDMS are people to whom drawings are issued. Controlled Documents should 
be issued under transmitt al to both External and Internal recipients.  Recipients are stored in 
an Address Book.  
 
18. From the main menu, select View and from the sub menu select Address Book.  
 

The Address Book will then appear as shown below.  
 

 
 

You are now going to enter a new co ntact Joe Fredericks from BigPond Construction. To 
do this you must first add BigPond Construction  as a company.  

 
19. Click on the Edit Company Details  button to the right of the word CompanyID, at the top 

center of the above screen.  
 

 
 

The Company Details Screen will then appear.  
 

 

19 

20 
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20. Click the New CompanyId  button on the toolbar.  
 

The Add New Company window shown below will appear.  
 

 
 
 
21. Enter the Company ID as BIGPOND and press Tab (This is a unique identifier for the 

Company). 
 
22. Enter the Title as BigPond Construction.  
 
23. Click the Add button to return to the Address Book. You will be returned to the Company 

Details Screen. 
 
24. Select Company Type  Button located at the right the of Company Details Screen.  

 
 
 
 
 
 
 

 
The Company Type Details screen will then be displayed. 

 
25. Click the New Company Type  button on the toolbar and the following screen will be 

displayed. 
 
 
 
 
 
 
 
 
 
 

 
26. Enter the Type as “BLD”. 
 
27. Enter the Title of the Type as “Builder” and click the Add button. Now click the Close 

button to return to the Company Details screen.  
 
28. Select Builder against BigPond from the drop down under Type as in the screen below.  
 
 
 
 

26 

27 

24 

21 

22 

23 
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29. Close this screen to return to the Address Book screen. BIGPOND will be selected as the 

current Company ID by default. (If not, jus t select BIGPOND from the Company ID drop 
down list). 

 
30. Click on the Create a new Contact  button on the Address Book Toolbar. The Add new 

Contact ID window shown below will appear.  
 

 
 

31. Enter the contact details as shown above and select the Add button. 
 
32. Click the Title drop down arrow on the top right of the screen and select Mr.  
 
33. Enter the rest of the details for this contact as shown below. Press Tab to move between 

fields. 
 

Position CEO 
Address1 50, MAIN ROAD 
City Hobart 
State, Post code TAS 7000 

 
 
 

30 

31 

29 

28 
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Note that the right hand side of the above screen is in fact two pages (see the Location 
and Default Details Tabs at the top right of the screen). The second page is the Default 
Details page and can be used to store a number of default values for e ach recipient. The 
screen below shows a completed Default Details page. The meaning of each field is 
outside the scope of this Guided Tour but they are generally self explanatory.  
 

 
 

34. Click the Close button on the Toolbar to close this screen.  
 
 
2.06 Generating a Transmittal  
 
A transmittal is a means of creating and recording the issue of controlled documents to 
recipients. Transmittals can be generated in a number of ways. The simplest transmittal 
generation method is to send one or more documents to a si ngle recipient. Note that 
regardless of the transmittal method used, all transmittals in QDMS are processed in the 
same way. 
 
35. From the main menu select Transmit and from the sub menu select Single Recipient . 
 

The Transmittal generation screen then appears as shown below:  
 

34 

32 

33 
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The Transmittal screen  has three pages (tabs) which are selected via the Tabs at the top 
of the screen. The first page is the Generate page where general information about the 
transmittal is defined such as the Recipient to whom the do cuments are to be sent and 
the reason for issue.  
 
The second page is the Documents  page, where the document selection is done. There 
are a number of ways of selecting documents for transmittal under “Type of Documents” 
located at the bottom of the Documen ts Tab.  
 
The third page is the Recipients page which is for selecting recipients when the 
transmittal is to multiple recipients. This will be covered in the Advanced Tour.  

 
36. Select the Documents page from the top of the form by clicking on the Documents  Tab. 
 
37. Locate the documents DUMMY -A, DUMMY-B AND DUMMY-C and type the letter T in the 

Tag column (extreme left column of the grid) against each of these documents.  
 
38. Now click on the Show Tagged for Tags Tick box in the bottom left corner of the above 

screen. 
 

Only documents tagged with the letter T will be displayed (scroll to the top of the list if 
necessary). You may notice there are documents tagged other than just DUMMY -A to 
DUMMY-C. To remove these documents from the list of tagged documents, delete the 
letter T in the Tag column against them. Then click the Show Tagged tick box twice (off 
and on again) and you will see just the three documents you need to transmit. 
(Alternatively select Clear from the Set Tag button to remove all Tags prior to Tagging).  

36 
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39. With your documents selected, you can now go back to the Generate Page (click on this 

tab at the top of the screen).  
 
40. Select the Recipient for this transmittal as BIGPOND from the Recipient drop down list at 

the top right of the Generate page if not  already selected by default.  
 

The other fields on the Generate page have the following functions 
 

Field Description 
Transmittal No This is an automatically generated sequential number for each 

transmittal. 
Reference No. This field can store a user defin ed or automatically generated alternate 

reference number.  
Transmitted by This is the Method of delivery of the transmittal.  
Acknowledgement 
Required 

If the recipient is required to sign and return the transmittal to 
acknowledge receipt, tick this box.  

Re-send 
Revisions 

If you want to ensure that future revisions of the documents being 
transmitted are also sent to the recipient, leave this box ticked. QDMS 
will then prompt via transmittals pending to re-send future revisions 
automatically. 

Copies, Size, 
Media 

These fields specify the number of copies, the size of documents and 
the media being sent. Note that these attributes can be defined per 
document using a Type 2 transmittal.  

Reason This is the reason why the documents are being issued.  
Message This is a message printed on the transmittal.  
Response 
required 

If the recipient is required to respond to the transmittal (eg approve the 
documents) you can select a response message and enter a response 
required by date. QDMS will then track outstanding a nd overdue 
responses. 

From This is the person the transmittal is from. Note that to set up the 
default transmittal sender you will need to add that person and his/her 
company into the Address book. You can then make this person as 
the default sender via Tools\Options\Program Defaults.  

 
Note that values in the various drop down lists for Reasons, messages etc are user 
definable via the View menu and sub menu Configuration Tables . More on this later in 
the Advanced Guided Tour.  

39 

37 

38 
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41. Click on the OK button to generate the transmittal.  
 
42. A preview of the transmittal will be displayed (assuming the destination was set to 

Preview which is the default). Click on the Print button on the Print Preview toolbar to 
send the transmittal to the printer.  

 
43. You will then be prom pted to save the transmittal. Click OK at the Save Transmittal 

form. 
 
44. The following screen will then appear showing that the Transmittal generated has been 

saved. Click the OK button and you will be returned to the transmittal generation form.  
 

 
 

45. Note that the Transmittal number at the generate screen has auto incremented to 7. From 
the Transmittal Generation Screen select Close button and again select the Close button 
to return to the Dashboard. 

 
 
2.07 View the Transmittal History  
 
Transmittal information in QDMS is stored in the Transmittal  History file. It is instructive to 
now view the transmittal you have just generated to see how it is stored in QDMS.  
 
46. From the View menu, select Transmittal History. 
 

 
 

Notice that the upper half of the screen di splays by default a register of all transmittals.  
 

47 

48 

49 
51 

44 
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47. Click on the row for Transmittal Number 6.  
 

In the lower half of the screen you will see the documents transmitted on transmittal 
number 6. 

 
There are three views for the above screen. The most useful vie w at any time is 
dependant on your reason for being in this screen.  

 
48. Try changing the view to By Recipient (using the radio buttons at the top center of the 

screen). 
 

You will now see the Address book in the upper grid and in the lower grid the documents 
that have been transmitted to each Recipient.  

 
49. Change the view to By Document No and in the top grid the Master Document Register 

is displayed. 
 
50. Locate document DUMMY -A to see who it has been issued to.  
 
51. Close this screen and return to the Dashboard using the Close button on the toolbar.  
 

Note it is possible to regenerat e a transmittal in it’s printed format from the above screen 
by simply double clicking on a transmittal number (the View must be By Transmittal) and 
selecting Preview from the two options th at appear. 
 
Note also that the Hot List button at the above screen enables the view to be 
immediately filtered for transmitted documents to which responses are outstanding and 
perhaps overdue or due in the next few days.  

 

 
 
 
2.08 Receiving Revised Documen ts 
 
You will now register revised versions of Documents DUMMY -A and B into QDMS to see how 
the system manages revisions to documents. While the document register can be updated 
directly with the new revision, the most popular method for recording the recei pt of documents 
is the Receive Documents  screen which you will now use.  
 
52. From the main menu, select Receive and then sub menu Documents. 
 
53. Enter the Trmtl#Rcvd (Transmittal Received) number as TR006 and press Tab twice. 
 
54. Select the From value as JKN from the drop down list.  
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Note that steps 53 and 54 above setup the general information that will be recorded 
against each of the documents you are about to enter.  

 
55. Press F4 to add a new document. At the Key Information window, type DUMMY -A and 

press Tab. You will get a message that the document exists in the MDR – click OK to 
continue and the Rev field will be populated with the current revision value for this 
document which is 1. Change the revision to 2.  

 
56. Click OK and see how the document is added to the grid with the existing title from the 

Master Document Register.  
 
57. Press F5 to add a duplicate document (this will save typing DUMMY -B) and change the A 

to a B at the document key information window for Document DUMMY -B. Press Tab, 
click OK and change the Rev to 2 and click OK. 

 
58. Click on the Close button. Click Yes when prompted to save your work and click No 

when prompted to enter another transmittal received.  
 
 
2.09 The Document History File  
 
QDMS maintains automatically a complete history of every revi sion of every document in a 
Document History file. Now that you have processed revisions to documents DUMMY -A and 
DUMMY-B it is time to have a look at this file.  
 
59. From the View menu, select Document History File (All revs).  
 
60. Locate Documents DUMMY -A and DUMMY-B and notice that there are two entries each 

for these documents. Notice also that information in the document history file cannot be 
changed which means the document history can be audited from here.  

 
61. Click on the Close button on the tool bar.  
 
 
2.10 Transmittals Pending 
 
When new revisions of documents already stored in QDMS are received, the following files in 
QDMS are updated:  
 

• The Master Document Register  gets updated with the latest revision.  
• The Document History File  is updated with all revisions . 
• The Pending Transmittals file is updated if the document being received has 

previously been transmitted. Transmittals Pending displays only recipients who do not 
have the latest revision of documents they have previously received.  

 
62. From the View menu, select Pending Transmittals. 
 

53 

54 55 

57 58 
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Notice that the recipient BIGPOND is one of the recipients displayed. This is because 
they currently have superseded copies of documents. Notice documents that are pending 
to be issued to BIGPOND are only DUMMY -A and DUMMY-B. This is because the 
document DUMMY-C which was transmitted to them previously, has not been updated 
with a later revision.  
 
It is a good idea to print transmittals pending for checking after receipt of a batch of 
revised documents. Simply click the Print  or Print Preview button on the Toolbar.  

 
63. Click on the Close button on the tool bar to close this screen.  
 
 
2.11 Transmitting Revised Documents  
 
The Pending Transmittals file is always updated as documents are transmitted and revised 
and can be cleared in only one of two ways:  
 
(a) Send the recipient the latest version of documents by transmittal.  
(b) Take the recipient off the distribution for the documents.  
 

One of the unique features of QDMS is that the distribution of documents is built automatically 
simply via the process of transmitting documents. This means there is no need to set up a 
matrix for distribution prior to issuing documents which is a great time saver. However, there 
are times when you no longer want to keep sending the latest revision of documents to 
recipients. In this case you can edit the distribution via the Recipient document register 
(available under the view menu). This is option (b) above and is not covered by the Guided 
Tour. 
 
You will now clear Pending Transmittals by sending BIG POND the documents pending for 
them. QDMS provides a special transmittal option for revised documents in which the system 
will select the required documents for each recipient to bring them up to the latest revision.  
 
64. From the Transmit menu, select Revised Documents. 
 
65. At the Generate page select BIGPOND as the recipient (Note that only recipients with 

superseded documents are available for selection)  
 
66. Click on the Documents  page and notice that the documents from Pending transmittals 

have been selected aut omatically for you. (ie Dummy -A and B) 
 

67. Click OK to generate the transmittal.  
 
68. Click Print at the Preview Screen and click OK to save the transmittal when prompted.  A 

confirmation window then appears. Click OK here too.  
 

63 
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69. Click Close and Close again when prompted. 
 

70. Finally, from the View menu, select Pending Transmittals and notice that BIGPOND is 
no longer listed. Click Close from the Toolbar.  

 
Note that Pending Transmittals gets updated regardless of the transmittal method used. If 
rather than using the Revised Documents Transmittal option you had simply tagged these 
two documents and transmitted them to BigPond using a simple transmittal, the effect on 
Pending Transmittals would have been the same.   
 
All transmittals in QDMS are processed by the system i n the same way and the different 
transmittal types are provided purely for convenience.  

 
 
2.12 View Transmittal History again 
 
With some more transmittal information, have another look at your transmittal history.  
 
71. From the View menu, select Transmittals History. 
 
72. Change the view to Document No at the top of the screen and locate Dummy Document.  
 
 
 
 

 
 
73. Click on the row containing Document DUMMY -A. 
 
Notice that DUMMY-A has been issued twice to BIGPOND.  

 
74. You might also trying clicking Print Preview with each of the different views displayed to 

get an idea of some of the reports available in QDMS.  
 
75. Click the Close button. 
 
 
2.13 Exiting QDMS 
 
To quit QDMS:  
 
76. From the File menu, select Exit and click Yes when prompted.  
 
You are now ready for the Advanced Guided Tour in Chapter 3. This will take you through 
an extended range of QDMS features and is essential reading if you want to get a feel for the 
power of QDMS.  
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3.01 Introduction 
 
The Advanced Guided Tour of QDMS introduces a  number of further conc epts and features 
of QDMS not covered in the Simple Guided Tour. If you are not already in QDMS, run the 
program and log into the Demonstration Project. If you are already have QDMS running, 
make sure you are back at the Dashboard. In the section below, al l actions start from the 
Dashoard. 
 
 
3.02 Managing Configuration Tables  
 
In the Simple Guided Tour you were introduced to the major files in QDMS such as the 
Master Document Register, the Document History File and the Transmittals History. In many 
of the screens in QDMS there are drop down lists from which you can select values. The 
Master Document Register and Transmittal generation screens in particular have many of 
these drop down lists.  
 
The values in the drop down lists are maintained in what are call ed Configuration Tables  in 
QDMS. Generally, wherever you see a drop down list in QDMS you can assume there is a 
Configuration Table associated with it where you can maintain your own values for that list. 
 
In this first activity in the Advance Guided Tour you will add a new Discipline value to the table 
that stores the library of Disciplines and also, add a new Message to the table that stores 
standard messages for use on Transmittals.  
 
1. From the View menu, select the sub menu Configuration Tables . 
 

 
 

The Group drop down lists has three options and controls the files listed in the Files drop 
down list. The three groups are:  

 
• Document Attributes  
• Transmittal Attributes  
• Address Book Attributes 

 
The File drop down list shown above lists all the Configuration  Tables in the selected 
Group available in QDMS. Use the scroll bar to see additional files. Once a file is selected 
the main grid displays the values stored in this file and actions on the da ta are performed 
using the toolbar as normal.  

 
2. From the Files drop down list, select Disciplines as shown above.  
 
3. Click on the New button and when prompted, enter the Discipline code as 6 and the 

Title for the Discipline as FITOUT. 
 
4. Click OK. 
 

Note that codes can be alpha -numeric. Eg your code for FITOUT could be FIT . 
 

Notice that you could print a list of discipline values by clicking the Print or Print Preview 
button on the tool bar.  

2 

3 
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5. Change the selected Group to Transmittal Attributes  and in the File drop down list 
select Messages that appear on Transmittals . 

 

 
 
6. Click on the New button and when prompted, enter the sequence number as 5 and type 

the message “This is a test message ”. 
 
7. Click OK. 
 

At this point you may like to view the contents of some of the other Configuration Tables. 
Some commonly used ones are:  

 
Transmittal Attributes 
 
Reasons:  To store standard reasons for sending documents to recipients such 

as For Information.  
Methods:  To store the methods by which documents are transmitted such as 

By Courier. 
 
Document Attributes 
 
Types:  To store Document Types s uch as Drawings, Specifications, 

Procedures. 
Status:  To store the library of Status codes.  

 
8. Click the Close button on the tool bar.  
 
 
3.03 Using Filters  
 
Filters are a very powerful tool in QDMS and as the amount of information you have stored in 
QDMS grows, filters become an essential tool to select information for reporting and viewing. 
Filters are in essence a method of selecting information that meets specified criteria.  
 
Filters are available throughout QDMS and always work in the same way. You will use the 
Master Document Register in this tour to see how the filters work.  
 
9. From the View menu, select the sub-menu Master Document Register. 
 
10. Click the Filter button  on the Toolbar to be presented with the standard Filter Expression 

Builder screen.  
 

 
 
The above screen shows the filter expression Title contains dummy . Looking at the 
component parts of this expression, Title is a field name in the Master Document 
Register. All fields in the master document register are available for use in the filter 
expression since this filter was activated from within the Master Document Register. 
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When the filter is activated in other files in QDMS, the fields available for use relate to the 
file currently in use.  

 
By selecting the Field Name value as Title, you are indicating that you want to filter for 
documents that have a certain value in the Title field in the document register. The Value 
field above is dummy. This means that the value you are filtering for in the title field is 
dummy. The Comparison  field above is set as contains which means that the title field 
must contain the word dummy. Note that a common mistake in QDMS is to use the 
incorrect comparison condition. For example, the filter Title equal to dummy  has a very 
different meaning to title contains dummy . In the former case, only documents that have 
the word dummy as the document title will be selected. Ie these documents will have no 
other text in the title other than the word dummy. In the latter case, the title only has to 
contain the word dummy and can contain other words and still meet the filter condition.  

 
Notice at the filter generation screen above that the filter can contain up to five lines of 
conditions. Multiple lines are joined together by either an And or Or condition. Notice also 
that commonly used filters can be saved for simple recall later using the Save and Load 
buttons. 

 
11. At the expression builder screen, select Title from the drop down list under Field Name 

and press Tab. Select contains from the drop down list under Comparison (you can 
scroll down to locate the contains comparison or just type c to locate it) and press Tab. 
Then type dummy in the Value box. 

 
12. Click OK to activate the filter.  
 

The documents you can see in the Master Document register should now be restricted to 
those shown below. 

 
13. Try using the Tab key to move across to the Discipline column on the Master Document 

Register. A drop down list for Discipline values will appear and if you click on the list you 
will see that your Discipline 6 – FITOUT is in the list.  

 

 
 
 
3.04 Customising the Master Document Register  
 
There are a large number of fields available for use in the Master Document Register. It is 
unlikely you will need to use all the possible fields when setting up projects in QDMS. As a 
result, you will find that w hen maintaining your data you are constantly tabbing across 
columns you don’t use which is inefficient. This can be overcome by customising the layout of 
the Master Document Register to suit your individual needs.  
 
14. With the document register open, click on  the Customize button at the top right corner of 

the screen. 
 

13 
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The Customise window above enables rearrangement of columns, making selected fields 
invisible and changing other attributes of columns such as font size. To demonstrate 
some of the possib ilities: 

 
15. Locate the field Received  (currently Column No. 9) and change the Column No.  value to 

2. 
 
16. Locate the field DocumentNo  and change the “Backcolor” to Yellow. (A drop down list 

will appear when you click in the field).  
 
17. Click Save and then OK and notice the change to the document register layout.  
 

This saved customisation is only for the current user. Other users may save their own 
custom views i.e. the custom views are not global, but are user specific.  
 
Note also that columns can be re -arranged by simply dragging the column headers to the 
left or right. Again, to save an arrangement, click customise and then save. Besides the 
“Default View” there are two additional custom views that can be stored at any time.  

 
 
3.05 Printing the Master Document Regi ster 
 
While still in the Master Document Register, it is time to see how simple it is to generate 
reports in QDMS. The print and print preview buttons on the tool bar generate WYSWIG 
(what you see is what you get) reports based on the current display.  
 
18. Assuming your filter is still active (the filter button is red when a filter is active), trying 

clicking print preview to generate a Master Document Register Report for Documents with 
Dummy in the title.  

 

15 
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19. Click  the Close Preview button on the Print Previ ew tool bar to return to the Master 

Document register and try the following:  
 

(a) Rearrange a column (eg drag the Sts column to the left of the Rev column) and click 
print preview again. Notice that the order of columns of the report has changed 
accordingly. 

 
(b) Change the width of the Title column by clicking and dragging the right boundary of 

the column heading to the left. Again print preview and notice the difference.  
 
(c) Click on the DocumentNo column heading and the order in which the documents are 

currently displayed will be reversed. Again print preview to see the difference.  
 
Note that the last item (c) above is an important concept in QDMS. The way data is sorted 
can be quite important and changing the sort order is as simple as clicking on the column 
header of the field to sort by. Clicking again sorts in reverse order.  
 
 
3.06 Master Document Register Views  
 
While the Master Document Register in QDMS stores only the latest revision of each 
document, it is possible from within the Master Document Register to view a revision history 
of documents and even the transmittal history if required.  
 
20. Before proceeding further, click on the Filter button again on the Toolbar in the Master 

Document Register and at the Build Filter Expression  screen click the Clear button and 
then OK to deactivate the current filter.  

 
21. At the top of the Master Document Register screen, click on the History File also radio 

button under Show to load the Document History file.  
 
22. In the upper grid which is still the Master Document Register, loc ate and click on the 

document DUMMY-A and notice the revision history below:  
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Notice that DUMMY-A has two entries in the Document History file. Note that a change in 
Status and/or a change in Rev triggers an automatic update of the document history.  

 
23. Now click on the Transmittals also  radio button at the top of the Master Document 

Register screen to load the transmittal history file.  
 

 
 

Notice that document DUMMY -A has been transmitted twice to BIGPOND, once at Rev 1 
and once at Rev 2. Scroll to the  right in the lower grid to see the transmittal details.  
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3.07 Receiving Documents  
 
In the next few sections of the Guided Tour you will explore some of the alternative transmittal 
methods supported by QDMS. First though, you will receive some more documen ts using the 
Receive Documents  screen. 
 
24. If you have not already done so, close the Master Document Register using the Close 

button on the Toolbar.  
 
25. From the Receive menu, select Documents . 
 
26. At the receive documents screen, enter the transmittal received nu mber as TR008. 
 
27. Select the From value as JKN. 
 
28. Press F4 to add a new document.  
 
29. Enter the Document Number as DUMMY -A, and press Tab. A message will appear that 

the document exists in the MDR and click OK.  
 
30. Press Tab, and change the Revision value from 2 t o 3 and click OK.  
 

 
 
31. At the top right of the screen, click the Columns button. Now in the columns window, 

scroll down to find the column Discipline and against this column, tick the box in the 
Visible column. 

 
32. Scroll down further to find the Zone column and again tick the box in the Visible column. 

Now click the Save button and the Discipline and Zone columns will appear in the Grid as 
shown above (you may have to scroll to the right to see the columns you have added) . 
Select values for the Zone and Disc ipline using the drop down lists.  

 
Note: If you want to select a document file (view file) to relate to the document you have 
just registered, right click in the Filename field to the right of the Title of the Document 
and choose Select File from the options. You will be taken to an open file dialog box, 
defaulting to \Qasoft\QDMS\CAD folder. Select file QDMS1.Pdf and click OK.  
 

33. Now press F5 to add a further document and enter the details for DUMMY -B. Change the 
Rev to 3 and click OK.  

 
34. Repeat step 33 for DU MMY-C which is an existing document (change the Rev to 2)  
 
35. Enter document DUMMY-D which is a new document (make the Rev 1 and the Title as 

Dummy Document D.  
 
36. Click on the Close button and click Yes when prompted to save the information you have 

entered into the Master Document Register and No when prompted to enter another 
transmittal received.  

26 
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3.08 Using Re-Transmit 
 
The most commonly used method of transmitting documents in QDMS is the Single recipient 
option to transmit a series of documents to a recipi ent. The documents on the Single 
Recipient transmittal option are selected by tagging them from the Master Document 
Register. The Re-Transmit Transmittal Received  option is very similar to the Single 
Recipient option, only the documents are selected automa tically based on the selection of an 
incoming transmittal number.  
 
In section 3.07 above, you processed a group of incoming documents against a transmittal 
received number of TR008. Using re -transmit you will now transmit these same documents to 
a recipient. QDMS will select the drawings for you.  
 
37. From the Transmit menu, select Re-Transmit Transmittal  Received . 
 
38. The first window that appears is for the  selection of the incoming transmittal number. 

Either Type TR008 in the Transmittal No. field or click on it on the lower grid to select it.  
 

 
 
39. Click OK to proceed to the transmittal generation screen, and click on the Documents  

page (the tab at the top of the screen) to see the list of drawings selected.  
 

Notice that the four drawings you input at 3.07 abov e have been selected automatically.  
 
40. Now click back on the Generate page and complete the fields on this screen as shown 

below. Select HOUSTON C ONTRACTING (HCC)  as the recipient.  
 
 
 

38 
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By using the drop down list for Messages you will notice that the mes sage you added to 
the Miscellaneous files in section 3.02 above is now available for selection.  

 
41. Click on OK to generate the Transmittal and Print after reviewing the preview. Save the 

transmittal when prompted and close the transmittal generation screen when finished. 
 
 
3.09 Using Auto Tag  
 
In the Guided Tours so far you have seen two ways of selecting documents for transmittal: 
Tagging and Re-Transmit. A third method of selecting documents is Auto Tag . This is a 
powerful feature of QDMS and can be used to automatically select documents for transmittal 
based on one of three options:  
 

Via a filter condition : For example to select all documents that have the word steel 
in the title. 
 
Based on a previous transmittal : For example, if last week you sent 35 doc uments 
to a person and this week want to send the same 35 documents to someone else.  
 
Based on the distribution : For example, you want to send all the documents you 
have sent in the past to Recipient A to a new Recipient B.  

 
There are even more things that  you can do with Auto Tag such as work out which 
documents in the Master Document Register a company has NOT received but that is for 
later. 
 
You will now use Auto tag to automatically tag the documents in the Master Document 
Register that have the word steel in their title, to select them for transmittal.  
 
42. From the Transmit menu, select Multiple Recipients . 
 
43. At the transmittal generation screen, click on the Documents  page. 
 
44. At the bottom left of the Documents page, click on the Set tags button and select 

Automatic . 

40 
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Note that Auto Tag can be used with all transmittal methods and the use of Multiple 
Recipients as the transmittal here is just in readiness for later.  

 
The Automatically Tag Documents screen will now appear. Notice the options available 
as per the introduction to this section.  

 
Note: It is always a good idea to cl ick on the Clear all Tags first  tick box at the bottom 
left of the Automatic Tags window (selected by default) to ensure that any existing tags in 
the Master document are removed d uring the Auto Tag process.  Remember always in 
QDMS that tags are only a temporary means of selecting documents for transmittal.  

 
45. Now click on the radio button That meet a filter condition . The Build Filter Expression  

window will appear.  
 

 
 
46. Set up the fi lter condition Title contains Steel  as shown above.  
 
47. Click OK to activate the filter and then back at the Auto maticaly tag window, click OK to 

perform the Auto tag process.  
 
48. Back at the transmittal generation screen Documents page, click on the Show Tagged  

for Tags tick box at the bottom left of the screen and you will see the selection of 
drawings that have been tagged automatically as shown below:  

 

 
 

Note that the Set Tags button can be used to clear tags as well as automatically applying 
tags. 
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3.10 Transmit to Multiple Recipients 
 
You are now going to generate another commonly used transmittal type which is a transmittal 
to Multiple Recipients. You should have selected this option at the start of Section 3.09. At 
this point you have selected the documen ts for this transmittal, but notice that the Recipients 
page (see the tab at the top right of the screen) is now active.  
 
49. Click on the Recipient tab and you will see the screen below.  
 

 
 
 

The Recipients page shows the contents of your Address Book. On a transmittal to 
multiple recipients, recipients can be Tagged in the same way that documents can be 
tagged on the drawings page.  

 
50. Enter the value R in the tag column against the Recipients BigPond Construction Limited 

and HOUSTON CONTRACTING . 
 
51. Click on the tick box adjacent to Print Distribution on Transmittal  at the bottom center 

of the screen. 
 
52. Click on the Show Tagged for Tags tick box at the bottom left of the screen to view only 

tagged recipients.  
 

Note that if you use the scroll bar to scroll to t he right of the grid, you will see columns for 
sequence, Copies, Reason etc. The sequence column is used to control the order in 
which the distribution will print on the transmittals. The reason is used to be able to 
define a different reason for issue aga inst each tagged recipient if required.  

 
53. Click OK to generate the Transmittals.  
 

Note that a transmittal to Multiple Recipients creates a uniquely numbered transmittal for 
each tagged recipient. QDMS also supports generating a single transmittal to a circu lation 
list but this is not covered in this guided tour.  

 
The first transmittal generated after clicking OK is for the first of the tagged recipients. 
Send this transmittal to the printer (from the preview screen by clicking the print button) .  
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Note at the Save Transmittal screen that there is a Save All button which if selected, will 
proceed to generate and save the remaining transmittals for tagged recipients.  

 
54. To see the next transmittal be generated, click OK rather than Save All.  
 

Notice at the preview that this is to HOUSTON where as the first transmittal was 
addressed to BIGPOND.  

 
55. Print and save the transmittal as normal.  
 
Back at the transmittal generation screen you will notice you are now up to transmittal 
number 11 for the next transmittal yo u will generate (click on the Generate page to see this).  

 
56. Click the Close button and Close again when prompted.  
 
 
3.11 Using a Free Form Transmittal 
 
There are times on a project when it is important to maintain a record that items other than 
controlled documents have been transmitted to recipients. This could include samples, a CD 
or diskette, or a report just to name a few. In addition to the above, there are also times when 
it is necessary to transmit a superseded copy of a document to a recipient. Sinc e QDMS 
transmits only from the Master Document register which stores the latest version of 
documents, this is not possible via any of the transmittal methods you have seen so far.  
 
The above scenarios are catered for in QDMS via a Free Form Transmittal whi ch can be used 
to transmit superseded or other documents not contained in the Master Document Register.  
 
57. From the Transmit menu, select Free Form Transmittal . 
 
58. At the transmittal generation screen, click on the Documents  page. 
 

 
 

You will notice Add and Clear Data buttons at the bottom center of the screen.  
 
59. Click the Add button and press Tab. 
 
60. Type SKETCH in the Document Number field and press Tab. 
 

58 

59 

60 



Chapter 3 – QDMS Advanced Guided Tour  

QDMS Version 5 Guided Tour    Page 40 

Since this document is not in the Master Document Register you will be prompted to 
complete the New document window details. Note however that this document will NOT 
be added to the Master Document Register but the details WILL be saved in the 
Transmittals History.  

 
61. Complete the details for Rev, Sts, and Title for the Sketch as shown above and click OK. 

 
Note that to transmit a superseded version of a document for which the current version is 
in the Master Document Register, type the correct Document Number in the field provided 
and the current details will appear. To change the revision back to the require d value, you 
must first adjust the document number. It is recommended to add an * or . to the end of 
the document number. You will then be able to edit the Revision via the New Document 
Details window. The change to the document number is forced as this en sures that the 
document is identified as NOT being the current Revision when transmitted.  
 

62. Click OK to generate the transmittal and print and save as normal.  
 

63. Close the Transmittal Screen as normal.  
 
 

3.12 Viewing the Transmittal History  
 
After completing the tasks above, you will now have a more interesting transmittal history and 
it is worth taking another look at this information now.  
 
64. From the View menu, select the sub menu Transmittal History. 
 
65. Click on the By Recipient radio button at the top center o f the screen to change the view.  
 

Locate the Recipient BIGPOND in the top half of the screen and click on this row.  
 

 
 
Notice that there are now a large number of documents transmitted to BIGPOND. The 
transmittals history is an auditable record of all documents transmitted to a recipient. To 
see only the latest versions of documents transmitted to BIGPOND, click on the check 
box at the top of the screen for Latest Transmitted only. 
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66. Try clicking the Print Preview  button to see the example report for the  transmittals 

screen. 
 
67. Click the Close button. 
 
 
3.13 Tracking Responses and Acknowledgements  
 
Your last task in this Advanced Guided Tour is to generate a few of reports. Managing the 
responses to document issues such as approvals required, is often a tim e consuming task. 
Getting acknowledgements back from Recipients to prove that they received the documents 
is equally hard. QDMS has a number of reports to assist with this process.  
 
68. From the File menu, select Print Standard Reports. 
 
69. Click on the Report on drop down list and select Transmittals - Details as shown below:  
 

 
 
70. Double click on Report Number 4R – Responses to Transmitted Documents . 
 

 
 

71. Click OK to generate a report list all documents that have been transmitted which both 
require a response and for which the response is outstanding.  
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Other options at the above window are further filter for only responses overdue or due in 
the next few days.  

 
72. Close the preview after rev iewing the report on the screen and click the Cancel button at 

the above window. 
 
73. Change the Report on selection to Transmittals – Summary at the top of the Report 

Generation window.  
 
74. Double click on Report Number 5C – By Trmtl No – Acknowledgements Outstanding  

to print a list of Acknowledgements Outstanding. Again close the preview after reviewing 
the report on the screen.  

 
Note that you could generate the above reports to Excel and email them to the recipients 
if required (see Other things to try in Section 3.14).  

 
Also to update QDMS when Acknowledgements or Responses are received,  go to the 
Transmittals screen (from the View menu) and with the View set on Transmittals, 
complete the Ackndate and Rspnrcvd fields accordingly. 

 
 
3.14 Other things to try  
 
You have now completed the Simple and Advanced QDMS guided tours. There are still many 
features of QDMS for you to explore. Some to try are as follows:  
 
Export data to other applications:  From the Wizards menu, select Export Data Files to 
export file types Excel, Lotus …  
 
Import and Export of Transmittals:  QDMS supports import and expor t of transmittals from 
and to other QDMS users. This can save a large amount of data entry on larger projects. Go 
to the Wizards menu and Export/Import Transmittal.  
 
Emailing of Transmittals:  If you send electronic versions of documents to recipients, QDMS  
can generate an electronic transmittal and what is more, it can also zip and auto attach the 
documents you are sending without leaving the program. Go to the Transmit menu and select 
e-Transmittal to generate the Email – Copies of Transmittals page. Note that you will have 
had to define the path and file names for your electronic document versions in the Master 
Document register first.  
 
Print Reports to Excel:  Have you ever wanted to generate a report and then email it to 
someone? Try File \Print Standard Reports and on the Right hand side against Destination 
Options, choose File and then Excel. This will publish any QDMS report to an Excel sheet.  
 
 
 
 



 

QDMS Version 5 Guided Tour    Page 43 

Chapter 4 - Appendices 
 
Appendix A Quick Start Instructions for Installing QDMS 
 

Appendix B File Formats supported by QVIEW 
 

Appendix C Work Flow for Initial Transmittal Generation 
 

Appendix D Work Flow for Transmittal of Revised Documents 
 

Appendix E Examples of some Customisations for QDMS 
 
 
 
 
 
 



Chapter 4 – Appendices 

QDMS Version 5 Guided Tour    Page 44 

Appendix A – Quick Start Instructions for Installing QDMS  
 
This set of instructions is provided to enable those familiar with installing software to get up 
and running with QDMS fast. These Quick Start instructions however, contain the key steps to 
installing and setting up QDMS.  
 
A.1 System Requirements 
 
The system requirements for running QDMS are:  
 
Hardware/Software Minimum 

Requirements 
Recommended 
Requirements  

Computer/Processor Pentium 250 
 

Pentium 800 

Memory (RAM) 64 MB 
 

128 MB 

Available Hard Disk Space  30 MB 80 MB 

Display 800 x 600 16 Bit  
 

1024 x 768 16 Bit  

Operating System Windows 98, Windows Me, 
Windows 2000, Windows 
NT, Windows XP 
 

Windows 98 

 
 
A.2 Software Installation  
 
A.2.1 The Windows Installer 
 
The Installation of QDMS requires the Windows Installer .  
 
If you are running Windows NT 4.0 or Windows 9 8, you must first update your Windows 
Installer to version 1.1 before installing QDMS. Contact QA Software to obtain details of how 
to get the latest Windows Installer.  
 
If you are running Windows 2000, you already have this installer and there is no need to 
reinstall this tool.  
 
You are now ready to install the QDMS application.  
 
A.2.2 Installing the QDMS Application 
 
1. Insert the QA Software CD and if it auto loads, simply click the Install QDMS  option at 

the QA Software menu and follow the installation ins tructions. QDMS will be installed in 
C:\Qasoft\Qdms\ by default. 

2. A short cut icon on your desktop will have been created to access 
C:\Qasoft\Qdms\Qdms.exe 

 
If the CD does not auto load:  
 
3. Using Windows Explorer locate the D: \Qdms\Setup folder and double cli ck on QDMS.msi  
4. Follow the install instructions as above.  
 
If you downloaded QDMS from the Internet:  
 
5. Using Windows Explorer double click on the QDMS.msi file you downloaded.  
6. Follow the install instructions as above.  
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A.3 Configure your work station 
 
1. If your monitor is not already set to a display of 800 x 600 pixels, you should change it to 

this setting before proceeding. To do this, right click on any blank space on your desktop, 
select Properties and then the Settings tab. Adjust the screen resolution to 8 00 x 600 
pixels. 

 
2. Create a shortcut icon on your desktop (if one was not automatically created during 

installation) to access the QDMS.EXE  (Located by default in the folder C: \Qasoft\Qdms\) 
 
 
A.4 Running the QDMS System 
 
7. Double click the QDMS icon on your  desktop. (Or use Start | Programs | QA Software | 

QDMS).  
8. At the login screen, the User ID = QA and the password is also QA.  
9. Select the Demonstration project by double clicking on the Project Name and you will be 

located at the Quick Menu. This is the sta rting point for all QDMS actions.  
 
 
A.5 Creating a Project 
 
Before creating your first live project you should have worked through the QDMS Guided tour 
using the Demonstration project. When you are ready to create your new project:  
 
1. From the File menu select New Project and click Next at the Welcome screen. 
2. Enter the Project Number and Title and click Next. 
3. At the Data Transfer screen, choose the Do not populate  option so that you will create a 

completely empty first project.  
4. Complete the remaining screens as required and click Finish when done. 
 
On completion of this you will be positioned in your new project automatically.  
 
 
A.6 Where to next 
 
Before you start processing documents and generating transmittals, the following areas of 
QDMS should be configure d: 
 
A.6.1 Populate the Address book  
 
QDMS supports the use of either a Project or Global Address Book for each project.  
For instructions on setting up your project address book, refer to the QDMS User Guide.  
 
The Address Book is located under the View menu and sub-menu Address Book . Note that 
the Address book is structured in two parts: Companies and Contacts. You must first setup 
companies before you can create contacts within each company.  
 
A.6.2 Setup Users 
 
Security in QDMS is controlled via User ID’s and passwords. You will need to create a User 
ID for each staff member requiring access to the system.  
 
1. From the Tools menu select Security – Users and Projects . 
2. Click on the Create a New User  button and complete the details about the new user.  

 
Tip: Set the User ID as the initials of the new user). The User should be allocated User 
Level 1 access at this stage.  
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3. Select the Projects that the new user may access by clicking on the Assign Users to 
Projects button and select from the list of projects in the left pane by double clicking on 
them.  

4. Return to the Dashboard and from the File menu, select Re -enter password to log in as 
the new user.  

 
A.6.3 Populate the Configuration Tables 
 
There are a number of miscellaneous libraries in QDMS that support drop dow n lists in 
various screens.  You should populate these tables with values to suit your business.  
 
The Configuration Tables are located under the option Configuration Tables  from the View 
menu. Refer to the User Guide for more details.  
 
Tip: See also the Quick Start Check List at the end of Chapter 1 of the QDMS User Guide.  
 

 
A.7 Installation of QVIEW 
 
QVIEW is QDMS’s optional integrated CAD viewer which is purchased as an add on module. 
To evaluate QVIEW you will first need to install it as follows:  
 
10. Insert the QA Software CD and if it auto loads, close down the auto loaded screen.  
11. Using Windows Explorer locate the D: \QView\Disk1 folder on the CD and double click on 

Qview.msi  
12. Follow the on screen setup instructions.  
13. Run QDMS and from the Tools menu, select Options and then Program Defaults. Click 

Edit and select the viewer as QVIEW. Then click Save.  
 
 
A.8 Support 
 
If you are having any problems with getting our software installed or getting started, please 
don't hesitate to contact our Technical Support Divi sion by Phone: +61 (3) 9326 8455, Fax: 
+61 (3) 9326 6544, Email: support@qa-software.com  
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Appendix B -  File Formats supported by QVIEW  
 
QVIEW is the optional integrated viewer for the QDMS Drawing Manage ment System. The 
File Formats supported by QVIEW as listed below:  
 
File 
Ext. 

Description File 
Ext. 

Description 

DRW Anvil 1000 SAT ACIS SAT File 
BGP Rx AutoImage VEC Data Design Systems 
CCP Calcomp DRW Personal Drg 
CG4 CALS Raster XWD X – Windows 
CGM CGM File XBM X - Windows Bitmap 
CIT Integraph Raster RAS SUN Bitmap 
DWF AutoDesk DWF IFF Amiga IFF 
DWG AutoCAD SLD AutoCAD Slide 
CRF Calcomp Raster XLS MS Excel 97 
DGN Microstation DOC Word 97 Doc 
DXB AutoCAD RTF Rich Text Format  
IG4 Image Systems G4 WPD WP 6.0/Win 
FLX FelixAD TXT Text Files 
GBR Gerber BIN Binary Files 
TG4 Integraph Tiled G4  HTM HTML 
PRT CadKey Print DCX Intel Fax format  
MI MP ME 10/30 GIF Compuserve GIF  
PLT HP-GL/2 JPG JPEG Picture  
PSL RxAI Edit Hybrid PCX PC Paintbrush PCX 
REF GTX Raster CAD WMF Windows Meta File  
RES CAD Overlay BMP Windows Bitmap 
RLC Run Length Coded  TGA Targa 
RND AutoCAD Rendering TIF TIFF Bitmap 
TG4 Tiled G4 RGB Integraph RGB 
VC4 Rx Vectoring PNG Portable Network Graphics  
VC5 Rx Spotlight RLE Integraph RLE 
WS Rx Spotlight PDF Adobe Acrobat 
XWS Rx WorkSpace   
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Appendix C - Work Flow for Initial Transmittal Generation  
 
The process of generating transmittals in QDMS is basically a combination of selecting 
documents from the Master Document Re gister and selecting a Recipient to send these 
documents to from the address book. The flow diagram below details the actions that occur 
during the generation of a transmittal of tagged documents to a recipient for the first time.  
 

 
 
 
Notes: 
a) Since Documents are selected for transmittal from the Master Document Register, this 

ensures that only the latest revision of documents are transmitted.  
 
b) Transmittals once generated are saved in the Transmittals file. This is like a filing cabinet 

of transmittals and cannot be edited.  
 
c) As transmittals are saved, the Recipient Document Register, which can be thought of as 

storing the distribution of documents, is also updated.  
 
d) Note that in QDMS there is no requirement to build a distribution matrix to enable 

transmittal generation. The process is simply a matter of selecting documents, recipients 
and generating the transmittals. QDMS builds the distribution (or matrix) for you 
automatically and this is stored in the Recipient Document Register.  
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Appendix D - Work Flow for Transmittal of Revised Documents  
 
The flow diagram below details the actions that occur during generation of transmittals for the 
issue of revised documents to a recipient who has previously received these documents.  
 

 
Note: 
The automatic selection of drawings in the above process is as follows: The revision status of 
documents in the Recipient Document Register is first compared by the system with those in 
the Master Document Register. Only those documents in the Recipient Document Register 
that do not have the current revision number in the Master Document Register are selected 
for transmittal.  
 
In order to prevent the system from generating numerous transmittals as soon as the revision 
status of a document is changed, the above will only take place au tomatically, when 
requested by the user. It is therefore recommended that such a request be carried out on a 
regular basis as a part of the QA Document Control Procedure (at least weekly) or more 
frequently after major updates to the Master Document Regist er. 
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Appendix E -  Examples of some Customisations for QDMS  
 
QDMS has been often customised for individual clients to meet their specific requirements 
since it’s creation in 1995.  
 
Some of the common customisations include:  
 

• Auto Numbering 
• Enhancements for the management of the Internal Document Review Process  
• Management of progress during the Design Phase  
• Preparation pf Custom Reports  

 
In the next few pages are some images of customised screens prepared for individual clients. 
Please contact QA Software if  you think you require any customisation of QDMS.  
 
Example of an Auto Numbering screen for Document Registration prepared for Devon Energy 
in Jakarta, Indonesia.  
 

 
 
Example Custom Menu prepared for BP Indonesia  

 
 
 
 
 
 
.  
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A Custom Document De tails screen prepared for BP Indonesia that includes auto document 
number plus management of the entire document review and approval process from a single 
screen. 
 

 
 
 
Example Internal Document Review Sheet developed for BP Indonesia. Notice that this 
allows for Multiple Circulation Lists on the same Transmittal when using a Flood Issue.  
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Custom Scheduling screen developed for Clough Engineering, Western Australia. Allows for 
the definition of Document Classes and Milestones with auto scheduling and for ecasting built 
in. 
 

 
 
 
Example custom report also developed for Clough Engineering, Western Australia  
 

 
 
 
 
 
 
 
 


